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General Information 
The Evapotranspiration map allows users to find evapotranspiration (ET) datasets for Idaho, display them on a 

map and calculate ET and consumptive irrigation requirements (CIR) statistics for their area-of-interest.  These 

statistics are derived using geoprocessing tools from Esri, as explained in the last paragraph of this section. 

CIR is the amount of water required for consumptive use that is artificially applied to the soil.  Seasonal CIR 

values do not account for the potential contribution of soil moisture accumulated during winter months.  CIR is 

negative where precipitation exceeds evapotranspiration. Only seasonal CIR values are calculated. No monthly 

values are provided.  

The ET datasets are developed using the METRIC  (Mapping EvapoTranspiration at high Resolution with 

Internalized Calibration) satellite-based surface energy balance model developed by the University of Idaho .  

The ET datasets are derived from multi-band Landsat  satellite data.  

The ET Viewer has built-in tools to help you select your area-of-interest using any of the polygonal feature-layers 

present on the map, such as irrigation companies, water rights places-of-use, etc.  See the section entitled 

Selecting Your Area of Interest from a Map Layer.  You can draw a polygon on the map to define your own area-

of-interest or load a compressed (ZIP-file) shape-file or KML from your device.  See the section entitled Selecting 

Your Area of Interest from a Layer You Added for details.  Your area-of-interest is used (much like a "cookie 

cutter") to define the portion of the ET dataset on which the statistics are calculated.  

This ET Viewer uses Esri's ArcGIS Server  GIS tools to help the user to locate their area-of-interest and compute 

the evapotranspiration (ET) and consumptive irrigation requirement (CIR) for that area.  ET/CIR statistics are 

computed using Esri's ArcGIS Zonal Statistics as Table  geo-processing tool. 

App State 
When you start the application on your device, if you have 
previously run the application a pop-up dialog will be displayed.   
 

This App State pop-up, depending on your device, will appear 
either across the upper third of your screen or at the lower, 
right corner of the screen. 

 

Tools Menu 
The menu, displayed on the left-hand side of the map, contains all of the tools you will need to select your area-

of-interest and compute statistics.  It also contains links to application documentation – including this document 

– and information concerning how to contact the IDWR.   

Hide or Show the Tools Menu 
The handle overlaying the left side, center of the map, can be used to hide or show the Tools menu.  The menu 

is initially hidden on mobile devices. 

Hidden (collapsed) 

 

Shown (uncollapsed) 

 

https://maps.idwr.idaho.gov/agol/EvapoTranspiration/
http://idwr.idaho.gov/GIS/mapping-evapotranspiration/
https://www.uidaho.edu/cals/kimberly-research-and-extension-center/research/water-resources
http://idwr.idaho.gov/GIS/mapping-evapotranspiration/landsat-thermal-band.html
http://www.esri.com/arcgis/products/arcgis-enterprise
http://help.arcgis.com/en/arcgisdesktop/10.0/help/009z/009z000000w8000000.htm


Customize Panel 
The tools in this portion of the menu are used to change the way the map looks and provide a pathway to 

features which help to organize the way your area-of-interest can be determined. 

Layer List Tool 
This panel contains all of the layers in the map, some of which are provided to help the user locate their area-of-

interest, except for background imagery.  The Layer List tool allows you to turn individual layers on and off by 

placing a checkmark in the box beside the layer name. Layers having expansion arrows indicate that they contain 

sublayers or subtypes.  The symbology for the layer can be shown by clicking those arrows. 

Basemap Gallery 
This panel contains all of the imagery available for use as a background.  Backgrounds range from satellite 

imagery to thematic maps to ones which resemble historical topographic maps or maps those found in National 

Geographic publications.  Note that the year in which the background imagery was obtained or drawn will not 

match the year of the ET dataset on which you are calculating statistics.  So, field-condition, land-lines, etc. may 

not exactly fit the boundaries of your area-of-interest.  You cannot supply your own background imagery. 

Add Data 
This tool allows you to add data from some “outside” source.  The Add Data tool enables you to add layers from 

ArcGIS Online or Portal for ArcGIS content, entering URLs, or uploading local files. You can remove these layers 

by clicking the LAYERS button at the lower, right corner of the Add data tool’s panel and then clicking the layer-

name, for example “Three PODs from district 57”.   

 

Although you may add any kind of data to the map, the ETStatistics tool only operates on polygonal feature 

layers.  You may add datasets that you, your agency or other agencies have shared via AGOL using the Search 

tab.  You can add data using a web-site address (Esri map service, KML, CSV, etc.), using the URL tab.  You may 

add files from your own device – shape-files, KML, etc. by using the File tab.  All of the individual components of 

a shape-file (.SHP, .DBF, etc.) must contained in a ZIP-file.  Note that multiple features from a zipped shape-file 

can be selected for processing and attributes can be viewed in the Attribute table.  Features from CSV, KML, 

GeoJSON, etc. must be processed one at a time and attributes cannot be viewed in the Attribute table.  

The layer you added will be shown in the Layer list.   
 

 

The size of uploaded files is limited. 
 

 

Select Features Panel 
The Select features tool allows you to interactively select features from the map (any visible layer) and take 

actions on the selected features. The most useful action, for this tool in this application, is to select features and 

pass them to the ETStatistics tool, to use as the input polygon.  Additionally, you can zoom to the selected 

feature(s), view their attributes in the attribute-table, save/export features, etc.  Note that, in order to use the 

Select features tool on a specific layer, you must place a checkmark next to that layer in the Layer list tool.  This 

tool explained in the “Select” section of Tools Used to Define Your Area of Interest. 



ETCIRStatistics Panel 
This ETCIRStatistics tool is the heart of the ET Viewer mapping application. When you open the panel, the 

following input-boxes and controls will be shown in order to define the input parameters for the ETCIRStatistics 

geoprocessing task.   

Input Parameters 

 

ET Raster – the ET dataset for which statistics 
will be calculated.  If no dataset is currently 
visible on the map, the most recent seasonal 
dataset is selected.  If you turn on an ET 
dataset, this value will be updated to reflect the 
visible dataset. 
 

Input polygon – draw your area-of-interest 
using the Extent or Polygon tool).  The Extent 
and Polygon tools allow you to draw a rectangle 
on the map.   
 

Besides using the Extent and Polygon drawing 
tools (icons to the left of the “trash can”) You 
can select those features in a number of ways, 
as explained in Tools Used to Define Your Area 
of Interest.   
 

You cannot select from layers that are not 
visible on the map. 

 

Note Concerning Size of Area-of-Interest 
The size of the polygon(s) you draw or select will determine how long the task takes to complete.  If you limit 

your requested input-polygon area to a few thousand acres the request should complete in under twenty 

seconds.  A request for a large areas-of-interest – e.g. Aberdeen Springfield Canal Company (slightly more than 

80,000 acres) – will typically take from eighty seconds to two minutes to complete, depending on server load. 

Warnings Concerning Size of Area-of-Interest 
If you request statistics for an area larger than 100,000 acres you will see a pop-up dialog with the warning on 

the left.  This application will not allow a request for any area over one million acres (1563 square miles).  In that 

case, you will see the dialog on the right.   

 

 

 

 



Tools Used to Define Your Area of Interest 
Use any of the tools mentioned below to define your own area-of-interest.   

 

If, when using the Set as input of ETStatistics tool, the Input polygon does not say “Use the resultant feature(s)” 

see Fixing Errors Encountered while using Features Selected from a Layer. 

Draw (Digitize) 
If your area-of-interest is not defined in any of the map-layers, use the Extent or Polygon tools – available in the 

Input polygon parameter of the ETStatistics tool – to draw the area.  Click a tool-icon to select it and then follow 

the instructions presented on the screen.  You must double-click* the map in order to close the polygon.   

If you need to draw more than one polygon, click the tool-icon and repeat the process.  You can add polygons 

and rerun the task even if you have already executed the task on previously selected polygons.  All of the 

polygons you draw will remain on the screen until you press the Clear icon (red trash-can) in the ETStatistics 

panel, even if you use other tools.  Do not clear selected features until you are done using them; there is no way 

to re-select the features without repeating the entire process. 

The method used to clear selected features varies depending on how those features were selected.   

• Identify tool – click the “X” in the Input polygon field, to dismiss the Use the resultant features(s) text 
and then click the Clear icon (red trash-can).   

• Select tool – open the Select features panel and click the Clear button. 

• Search tool – click the “X” in the Search tool’s text-box. 
 

Identify  
Turn on the layer containing the polygon which defines your area-of-interest.  Click on that polygon – this uses 

the Identify tool.  As shown in the image, the identified polygon will be highlighted and a pop-up dialog will 

display the attributes associated with that polygon.  There may be several overlying features which include the 

point you clicked, so it may be necessary to use the arrows at the top of the dialog to “page through” the 

entities (in this case, a large water right) until you find the correct one.   

In areas of the map where there are many overlapping features, it may be best to use this tool.  In this 
example, there are four overlapping water rights as well as many PLSS features.     

Click the right/left 
arrows at the top of 
the pop-up dialog to 
select a feature – the 
6th features of 7 is 
selected. 
 
Click the ellipse at 
the bottom of the 
dialog and click the 
Set as input of ET 
Statistics button. 
 
 

Using the Identify, Search or Select tools: 
If you select your area-of-interest using one of these 
tools, and click Set as input of ETStatistics from the 
context-menu, the Input polygon will look like this. 

 



 
 

When you see the correct feature, click the ellipses icon (the 
three “dots” at the bottom of the pop-up dialog).  Click the 
Set as input of ET Statistics button.  

 

The ETStatistics panel will be displayed showing Input polygon as “Use the resultant feature(s)”.  Click Execute. 

Search 
As when using the Identify tool, turn on the layer containing a polygon which defines your area-of-interest.  Click 

the Search tool’s down-arrow icon and select the layer to search, e.g. Water Right # or POUID.  Enter the search-

string (water right # or POUID) and click the magnifying-glass icon.  If results are presented below the Search 

tool, click on the appropriate item.  Perform the same operations explained in the Identify tool. 

Select 
Using the Select tool works much the same as the Identify and Search tools with one exception.  Since you are 

able to select multiple features from multiple layers, once the selection has been made, chose Set as input to the 

ET Statistics, in the Select tool’s context-menu (click the ellipses “…” next to the layer from which you made your 

selection).  To avoid confusion, place a check in the check-box of only the layer on which you wish to operate. 

Note that you may only use the Identify or Search tools for layers you add to the map; you cannot use the Select 

tool. 

 

Open the Select tool’s panel and click the Select button 
to highlight it (a bright border will surround the 
button).  You will not be able to select features from 
any of the layers that are not currently visible on the 
map – those layer’s checkboxes will be disabled and the 
layer titles will be shown in gray text. 
 
The tooltip on the Select button tells you how select 
features by drawing on the map. 
 
Check any layers you wish to make available for 
selection.  In this example the tool will select (and 
highlight) ESPA Model Grid cells, water rights and 
polygons representing irrigated lands for 2011. 
 
Draw a polygon on the map – it must be a polygon of at 
least three sides.  You cannot complete the operation 
with a single point or line. 



 
Polygons from several layers may be highlighted. 
 

 

 
The list shown in the Select tool’s panel tells you how 
many polygons were selected for each visible layer.   
 
 

 

Click the ellipses for the layer that you want to use.  
In this example, the Water Right layer was selected.  
Because the Select tool has so many capabilities, in 
the figure to the right the list of Selection actions 
has been shortened.  The full list includes options to 
export the features (or just the attributes), create a 
new map layer, etc. 
 
Click the Set as input of ET Statistics button.   
 
The ETStatistics panel will be displayed.  Click the 
Execute button to run the task.      

Fixing Errors Encountered while using Features Selected from a Layer 

Note that, on occasion, the ETStatistics tool will not acknowledge that the Select or Identify tool was used to 

specify features for which to calculate statistics.  In that case… 

opening the ETStatistics panel will display: 
 

 

If you click the Execute button, you will see this: 
 

 
 
Click [once again] on the Select features panel and 
choose Set as input of ETStatistics from the context 
menu of the layer from which you selected 
polygons.  The screen should now show this ➔ 

 

 



 

Selecting Your Area of Interest from the Attribute Table 

You can select multiple features from the Attribute table.  Multiple records may be selected by using Ctrl-click or 

Shift-click.  You can modify the selection you made on the map. 

 

Selecting Your Area of Interest from a Map Layer 

You can select your area-of-interest from any of the polygonal layers.  Selecting a large area-of-interest 

(exceeding 100,000 acres) may cause the ET Statistics geoprocessing service to “time-out” before it returns 

results.  We currently have ten irrigation companies which exceed this amount.  In a “worst case scenario” the 

service may fail, causing an outage while it resets.  This increases your wait-time for statistics.   

Running the task on individual or multiple features from the ESPA Model Grid, Irrigated Lands, Irrigation 

Companies or Water Right (including permits, claims and recommendations) layers will yield results.  However, 

doing so on the ESPA model outline, county or administration basin will not!   

Selecting Your Area of Interest from a Layer You Added 

You cannot use the Select tool to select multiple polygons from added layers.  Use the Identify tool to highlight a 

feature from the layer you added to the map.  Follow the instructions for the Identify tool. 

Double-Selecting an Area 

Note that if you select multiple areas-of-interest so that they overlay, the polygons will be simplified and merged 

so that the geometry used to calculate the statistics will be properly formatted.  For the example image, below, 

the total area selected covers two complete Public Land Survey System quarter-quarter-sections, which is 

approximately 80 acres.  That area will be used for calculations. 

  



Calculating ET and CIR Statistics  

Executing the Task 
Once you have identified your area of interest, click the Execute button.  When the task associated with the 

ETStatistics tool completes, the output results will be displayed in the Output tab. 

Output Results 
The ET/CIR statistics are presented in the Output tab of the ETStatistics tool.  The panel shows which ET dataset 

(if requested, the CIR dataset is for the same period of time) was used, the name of the input polygon and the 

statistics for the give area-of-interest. 

Explanation of Output tab 

 

  Enlarge View – displays a pop-up dialog, showing 
detailed statistics –max, standard deviation, etc. 

 

Export – export the ET/CIR statistics  
• Export to CSV file is the only way to download 

the statistics as a file. 
• Statistics… (not useful in this context) 
• View in Attribute Table does not allow for 

downloading as a file. 
 

 
 

Enlarged View 

 

  



View in Attribute Table 
The columns in this view can be resized, rearranged or hidden in order to make it more presentable.  Note that 
the OBJECTID_1 column contains the OBJECTID of the feature layer used to define your area-of-interest. 
 

 

 

Hiding VARIETY, MAJORITY, etc.

 
 

Reviewing Previously Calculated ET Statistics  
You can view statistical output from earlier calculations (from the same browser session).  Open the Customize 

panel then open the Layer list tool.  Select an output table, click the ellipses and select View in Attribute Table. 

 

The statistics will be shown in the attributes table.  As mentioned above, the columns can be resized, rearranged 

or hidden in order to make it more presentable.  Note that the Export all to CSV – or Export Selected to CSV – 

option is meant for feature layers, not evapotranspiration calculations.  The only way you can save previously 

generated evapotranspiration statistics is to select the rows in the Attribute table, using a mouse or touch-

gesture, and use Ctrl-C (or equivalent) to copy the Attribute table’s contents, then paste them in your document.  

Statistics from a current calculation can be downloaded, as mentioned on the previous page. 

 

  



Feature-Names Displayed in Summary of ET Statistics Output  
The application may or may not be able to determine the name of the features for which statistics were 

calculated. 

The following is displayed when the user digitized one or more polygons on-screen.  It will occasionally appear 

when the software cannot determine how the area-of-interest was chosen. 

 

The irrigation companies were turned on and the Blackfoot Younie Ditch Co. was identified. 

  



Errors Calculating Statistics 
If you have not selected an ET dataset, the default 2016 seasonal dataset for Paths 39/40 will be used for 

calculation.  That dataset covers the Eastern Snake Plain aquifer.   

If you see the following display in the ETStatistics tool, your 
area-of-interest does not interest the currently selected ET 
dataset.   
 
In the example, below, a polygon was selected from the 
Treasure Valley 2015 irrigated lands feature-layer.  It is in 
western Idaho…and the default (eastern Idaho) ET dataset is 
used for calculations. 
 
You can tell by the image that the irrigated lands and a 
background image are show but no ET dataset is shown.  

   

 

Turn on the correct dataset (2015 seasonal dataset for Path 42) from and try your request again.  Now the pixels 

representing the ET dataset are clearly visible. 

    



Appendix –  Tools Positioned on the Map 
These tools are represented as icons which overlay the main map.  In general, they are useful in manipulating 

the extent of the map. 

Extent Tools Shown on the Map 

 

Zoom in – make features on the ground appear larger 
 

Zoom out – make features on the ground appear smaller 
 
 

Default extent – Zoom out to view the entire State of Idaho 
 

My location – turn on your device’s GPS and click this icon to zoom to your current location and put 
a marker on the map at that location 
 

Previous extent – return to the previous extent (the last view of the map before you zoomed or 
panned the map) 
Next extent – return to the next extent (this is useful if you used the Previous extent button 

 

Search Tool 
The Search tool is used to find an area on the map based on any of the following: 

  

Explanation 
Click on a specific search-item to avoid 
searching all layers on the map. 
 

A search for “PLS – quarter quarter” will 
bring up all QQs in a given township/range 
if you do not specify the section and QQ.   
 

A street address, city name or place-name 
(name of a park, well-known landmark, 
etc.) can be used. 
 

A CELL_INTGR code (e.g. 1082135) must 
be used when searching for an ESPA 
Model grid-cell.   
 

Latitude/Longitude coordinates are 
entered like 116.1940W, 43.6089N. 
 

Extent Tools Not Shown on the Map 
The Pan tool is the only tool that is hidden from view. 

Pan Tool  
Unless you have activated a tool that uses the cursor to interact with the map (the Select tool or the onscreen 

drawing tool used in the ETStatistics tool) you can pan the map-extent by doing the following: 

1. click on the map 

2. hold down the mouse-button  

3. drag the map to re-center it.* 

* These instructions are written from the standpoint of a desktop or laptop computer user.  Where any reference to a mouse ar e 

used, you can replace those words with the appropriate pointing device – for mobile-friendly devices the terms for gestures such 

as “swipe”, “pinch”, “tap” or “double-tap” would apply. 



Application-specific Tools 

Swipe Tool 
The Swipe tool is used to expose a portion of the underlying layers (usually the background image) by partially 

removing an overlying layer. 

Use the Swipe tool by clicking the icon, located 
beneath the Search tool. 
 

 
 

You will be presented with a list of layers which you 
can “swipe” (e.g. an ET dataset, irrigated lands 
polygons, water rights, etc).  

 

Using the Swipe Tool 
When the Swipe tool is made active, you will see a bar which divides the map-screen in half, vertically.  Click on 

the bar and move it left/right to expose more or less of the background layers.  The following examples show 

the same geographical area. 

 

Irrigated lands polygons over background imagery. 

 

Irrigated lands polygons over ET dataset. 

 

ET dataset over background imagery. 

 



Appendix –  Using Mobile Devices 

Identify 
The operation of this tool is the same as for non-mobile computers except the pop-up dialog, which displays the 

attributes of the features, is drawn differently.  As previously noted, there may be several overlying features 

which include the point you clicked; there may be many features within the same layer.  If multiple results are 

shown, use the arrows at the top of the dialog to “page through” the entities to find the layer/feature that 

defines your area-of-interest (in this case, PLSS quarter-quarter section 07S30E23NWSE).   

The boundary for the identified “PLS – quarter 
quarter” is highlighted.  Click the arrow at the right 
side of the header to display the attributes. 
 

 

Click the ellipses, at the bottom of the dialog to bring 
up the context menu. 
 

 
 

 

 

 



Running the Statistics 
Click Set as input of ETStatistics button.  Click the 
minimize icon (the “down arrow” at the right-end of 
the title-bar) to minimize the dialog.   
 

 
 

The screen will look like the first screen-shot of this 
paragraph.  Open the ETStatistics tool (if it is not 
open) and proceed as normal. 
 

 

As mentioned here, the ETStatistics tool may not acknowledge that the Select or Identify tool was used to 

specify features for which to calculate statistics.  In that case, return to the minimized dialog, maximize it and 

click the Set as input of ETStatistics button.  Click the minimize icon and then the Input polygon’s value [in the 

ETStatistics tool] should be “Use the resultant feature(s)” as shown in the screenshot, above, right. 

 

 


